How to use ICC12 with Adapt912B32 and FLASH Loader

This document will show and demonstrate the use of ImageCraft ICC12 Latest
Version 6 with Technological Arts’ Adapt912B32 module.

The FLASH Loader written by Gordon Doughman Arts and can be found at
www.freescale.com website. The FLASHLoader will be used here to erase and
program FLASH after the compilation of a test program. Other method can be
used to also erase and program the FLASH but in this example it will be the
FLASH Loader.

This document assumes that the user is familiar with C and so will not teach how
to program C here.

ImageCraft Links:

[CC12
Yerzion 6. 164 Built Jan 26 2004 21:58:23

» [E50) 4939326 Fax: (B50] 433-9329
Copyright [C] 1998-2002 |mageCraft Creations [ne.

ailing Lizts: hitp: /A, dragonzgate. net/mailmandlistinfo

Wwieh Site: hitboe vy imagecraft, comyd sofbware

Demo/Updates:  http:AAvavn imagecraft. comydsoftware/demosz. hitml

Ermail Suppart; mailko: supporkiEimagecraft, com

Lizenze Request: mailto:licensel@inagecraft, com

Savlo ting LURL:

http://www.imagecraft.com/software/
http://www.ece.utexas.edu/%7Evalvano
http://www.dragonsgate.net/FAQ/cache/20.html
http://www.imagecraft.com/software/mdevtools.html
http://www.dragonsgate.net/mailman/listinfo

Freescale Link:

http://www.freescale.com/
http://www.freescale.com/files/soft dev tools/software/app software/dbug rom
monitors/MC68HC912B32EVBFW.zip




Getting Started:

Double click on the ICC12 icon. If a user has not read the ICC12 manual and
just open the IDE one will wonder what to do next. Well wonder no more.

Note the 3 window panes. The top left most is greyed out and the right is the
project window. The left bottom pane is where the error messages are displayed
during compilation.

Before creating a new Project, the hardware target in the Compiler Options must
be setup properly for the target MCU. This is to ensure that the compiler will
setup the type of MCU the C program will compile for. In this example it is the
Adapt912B32.
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Compiler Setup:

Click on Project Menu — Options — Target Tab.
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Please note the Device Configuration. Click on the pull down arrow to change
the device type.

Compiler Options |
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Scroll up or down to select 912B32 as shown.



Select 912B32.
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Device Configuration:

Program Memory: 0x8000
Data Memory: 0x0800
Stack Pointer: 0x0C00

The program code is allocated to start from 0x8000. The internal RAM is to start
from 0x0800 and the stack is to start from 0xOCO0 and work downward.



On the compiler tab there are several choices of S-record output as shown.
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Select which one that suits you.
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Starting a new Project:

Once the compiler options are setup, a new project can be created. Click Project

menu — New.

* ImageCraft IDE for ICC12 (PROFESSIONAL)

Fil= Edit Search View | Project RCS Tools Terminal Help

—_———
D e do M
Open Al Files

Close All Files

Crrl+F11

=10l x|

} =

Reopen...

Make Project
Retuild &l

=l
Shifb+FS

Add Filefsh...

ShiftHF1L

£dd Tepmost Spened File
Remaove Selected Filels)

DpLions. ..

Manual Sort Browser Window

Clase
SEvE AS...

Project I Browser |

------ I8¢ NO PROJECT OFEN

| |[ Mo Open File |

|[No Open Praoject | |519

A4

The ICC12 will prompt to save the new project. The user should decide whether
to create a new directory to save the new project. In this example a new
directory called Test is created and the file is saved as file test.prj.

Save New Project As...

Save in: | < Local Disk [C:]

~| &« @& e BB

2x

Temp

Templ
Tempz
ternp3
Temp4
TempS

1

File name:

Chusr

[ WINDOWS
CwUTemp
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Open I
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Type the filename as test.prj and click on the Save button.

Save in:l@ Test j = % ER-

File name: Itest.pri |i|
Save as ype: IF'ru:uiect Files [*.pri] j ﬂl

Note that the project window has changed to add Files, Headers and Documents.
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Creating a new file to the project:

To add files to the project, click on the File menu — new as shown.
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Note that ICC12 created an untitled file. Save the file as BlinkLED.C.

* ImageCraft IDE for ICC12 (PROFESSIONALY

File Edt Search Wiew Project RCS  Tools Terminal Help

Mew

Reopen...

DPEn. ..
Reload. ..

Close:

Compile File, ..

Sae &l
Close all

Save Chrl+5

Print

Exit

=131 ]

BG S eDnEE

Project | Erawser I

=% TEST

oy Files

~23 Headers
+23 Documents

|E “Testhtest pri

[513




ICC12 will open an explorer window to help save the file. Type BlinkLED.c then

press the save button.

Save in:lb Test j = £ E-

File name:

Save I
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Note that ICC12 has renamed the file to BlinkLED.c.
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To add BlinkLED.c to the Project, click on the Project menu — Add File(s)
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ICC12 will open an explorer window to help and locate the file of interest.

Look i: I ) Test
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File name:
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Note that the right window pane has changed to include BlinkLED.c under the
Files Project.
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Locate vectors.c and copy file to Test directory. The major reason why this
must be done is because of project to project dependency. It is not good to keep
editing a single vectors.c if other projects are using this same file. It becomes a
problem to keep track of the changes made to the different projects.

To add vectors.c to the Project, click on the Project menu — Add File(s)

Lok in: | L Test | & & cF E-
= BlinkLED

veckors,

Filz name: |vectnrs.c Open I
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Note that ICC12 has changed to include vectors.c It is important to note that the
vectors.c was written for the 68HC912B32 and 812A4 MCUs. This example
edits the line #pragma abs_address:0xffd0 to #pragma abs_address:0xf7d0

The original vector address OxFFDO is changed to O0xF7D0. This is because the
FLASH Loader resides from $F800 to $FFFF.
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if you use Eey Wakeup H, change the start address to Ox££CE and
add one entry to the heginning *#/
DUKNY ENTRY, /t BDLC #f [t Hey Uakeup J #/
DUKNY ENTRY, ft LTD %/ Jt LTD %/
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Write the codes below into BlinkLED.c file. Once it is written we can then




compile/make/build the code.
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Pﬁinclude "312h3Z. "

void hlink delay{voidj;
void waing)
{
COPCTL = 0x00; J/Clzar COP to dizshle Uatchdog

DORF = 0xFF;
PORTP = OxFF;

blink delay();

while (1)
{

PORTR = OxFF; //LED on
hlink telay();
PORTR = 0x00; /JLED off
blink delay();

void blink delay(void)
{
int i;
for (1=0; i<64000; 1+4)
{
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ERLA)

=& Fies
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11 CTemp\TestBlnkLED ¢ DA Templ\Teshest

BE




#include "912b32.n"

void blink_delay(void);
void main()

{
COPCTL = 0x00; /[Clear COP to disable Watchdog

DDRP = OxFF;
PORTP = OXFF;

blink_delay();

while(1)

PORTP = OxFF; //LED on
blink_delay();
PORTP = 0x00; //LED off
blink_delay();

}

}

void blink_delay(void)
{

inti;
for(i=0;i<64000;i++)
{

}



Compiling/Build/Make the file:

To make the file click Project menu — make project as shown.
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FORTFP = Ox00; F/LED off
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void blink delay(void)
<
int i:
£or (i=0:;i<64000; i++)
4
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Note the bottom window pane will show messages to display how the build

progressed. Any errors, if any, are shown in this window. The build was without
error so we can progress to erasing and programming the 912B32.
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#include "21Zb32.h0"
void blink delay(void):
roid mwain()
{

COPCTL = 0Ox00;

DDRP = OxFF;
PORTP = OxFF:

blink delay():

while (1)

FORTP = OxFF; Jf#LED on
blink delavy():
FORTP = 0Ox00; //LED off

blink delay(}:

1

void blink delay(void)
{
int i;
for (i=0;1i<64000; i++)|
{

i

ff{Clear COP to disable Watchdog

[

Done.
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Note the other extraneous files are created after a make.

% C:. Templ'Test =10 x|
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G Back - \_/J . ‘1}‘ , ) Sgarch u__ Folders E - x n gg
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l«:l BlinkLED.c 1 KE C source file 91212005 1:16 PM
test. pri 1KE Embeddedahl Proj.., 91272005 1:17 PM
) TEST.SRiC 1 KB SRC File Q1212005 1:12 PM
l.jl: veckors.c 2KB C source file Qf12/2005 1:17 PM
o BlinkLED, _c OKE _CFie 9/12/2005 12:56 PM
= BlinkLED, dp2 1KE DPZ File 9122005 1:17 PM
=T r;] BlinkLED:.lis 3IKB Text Docurment Q1212005 1:17 PM
D¢ BIinkLED.l:u 1KE 0O Fie 9/12/2005 1:17 PM
D BlinkLED.s 1KE 35 File 9/12/2005 1:17 PM
D test.lk 1 KB LK File 91212005 1:17 PM
o test. sk 4 KB list file 91212005 1:17 PM
D test.mak 1KE MAK File 9/12/2005 1:17 PM
= test.mp ZKE MP File 9122005 1:17 PM
D tEest.:'-l'El 1KE 5S19File Q1212005 1:17 PM
o ‘ weckors, _cC ZKB _CFie FIFIZ002 1:34 AM
=% vectors.dp2 OKE DPZ File 9/12/2005 1:17 PM
- r;] veckors lis 2KB Text Docurmenk 91212005 1:17 PM
- vectu:nrs.u:n 1KE 0OFie 91212005 1:17 PM
Eh= - veckars.s 1KE SFile 91212005 1:17 PM
4 | _"|_I

Using WordPad to check the content of test.s19 file. Note that the S-records are

of different lengths.

S10E8000CF0C0016806B87CEO08008EAA
S110800B080027056A000820F6CE8070CD1D
S111801808008E80702706180A307020F516B6
S1078026802A20FE8A

S111802A790016C6FF7B0057C6FF7B00561672

S1108038804D200EC6FF7B005616804D794A

S1118045005616804D20F03D34B7751BO9ECCBE
S111805300006C1E2007EC1EC300016C1EEC26

S10D80611E8CFA0025F2B757303DDB

S111F7DOFFFFFFFFFFFFFFFFFFFFFFFFFFFF35
S111F7DEFFFFFFFFFFFFFFFFFFFFFFFFFFFF27
S111F7ECFFFFFFFFFFFFFFFFFFFFFFFFFFFF19

S109F7FAFFFFFFFF800089
S108806B1D0016073D95
S90380007C




Examining S-record:

If one looks closely at the S-record one can see S1 to be of different lengths.
This is atypical S-record generated by ICC12.

As stated previously, FLASH Loader occupies $F800 to $FFFF therefore the
vector address at below $F800.

Note the content of the memory address at $F7FE:$F7FF is $8000, the pseudo
RESET vector.

S111F7DOFFFFFFFFFFFFFFFFFFFFFFFFFFFF35
S111F7DEFFFFFFFFFFFFFFFFFFFFFFFFFFFF27
S111F7ECFFFFFFFFFFFFFFFFFFFFFFFFFFFF19
S109F7FAFFFFFFFF 800089

The S-record below is the start of code. The content of address beginning at
$8000 to $8050

S10E8000CF0C0016806B87CEO08008EAA
S110800B080027056A000820F6CE8070CD1D
S111801808008E80702706180A307020F516B6
S1078026802A20FE8A
S111802A790016C6FF7B0057C6FF7B00561672
S1108038804D200EC6FF7B005616804D794A
S1118045005616804D20F03D34B7751BO9ECCBE
S111805300006C1E2007ECT1EC300016C1EEC26
S10D80611E8CFA0025F2B757303DDB



Programming the Adapt912B32:

Open ICC12 terminal window by Selecting Show Terminal Window. Connect
Serial cable to any available PC COM port and the other end to Adapt912B32.
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#include "91ZB32.hL" ——l
void blink delayivoid):
roid wain()
{

COPCTL = Ox00:

LDRF = OxFF:
PORTP = OxFF:

Blink delayi():

while (1]

PORTFP = OxFF;
blink delay():
PORTFP = Ox00;
blink delay():

/4LED on

/4LED off

¥

void blink delay(void)
€
int i:
£or (i=0:;i<64000; i++)
€

¥

f/Clear COP to disabhle Watchdog
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3 Documents
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Set the COM port parameters under Tools-Environment Options and then

Terminal tab.
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Select the COM of your choice, BAUD = 9600, Flow Control =

None and ASCII

Transfer Protocol to Wait for * (Flash). Press OK button to continue.

Environment Options

Preferences  Teminal |

COM Portt——— —Floww Control

= COMA {* Mone

" COM 2 = Hardware [CTS5/RT5)

" COM 2 " Saoftware ["5/70)

- COM 4 " Keep DTR &ctive
Baudrate: —ASCI Transfer Protocol———
I | "I " Mone

i~ Line delay [mz.] IT
T erminal Font... | % it for ** [Flagh)

X

ok

Help |

Cancel |

In the middle is the Open Com Port button. Double check the serial
Connections between Adapt912B32 and at the back of the PC. Click to connect.
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Warning!: Make sure Vfp SW3 is in OFF position before powering unit. Failure
to do this will damage the MCU. Move Mode Select JB2 PADO0:PAD1 = 1:1.

Power up unit or press the RESET button if already powered

Mod

%

[ Vfp Switch

gp:smf
i

15 R A N N N R XN X NNNNNJNXNRNENERZSE:RXN
L N A R N N A K LN NN N NRENENHNERHNSRSZEJJN -

* ' ImageCraft IDE for ICC12 (PROFESSIONAL)
File Edit Search View Project RCS Tools Terminal Help

up.

e Select

RESET Button

=10/ x|
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ﬂ Dowrload File:

IC:\Asm\T echat\MNEB4WAdaptas]

Browse... |
Download! |

{E>rase. {(P)rogram or {L)>oadEE:

Cloze Com Paort |

Show Editars |

o

KIS |

Cihiccibin imakew -f test.mak -
icelzw —c -IC:Yicchiincludey -2 -1 C:%Tewpl)TestiBlinkLED.c
icelzw —c -IC:Yicchiincludey -8 -1 C:4Templ)Testhwvectors.c
icelZw -0 test -LC:hiechlibl -btext:0xS000 -bhdats:0x0800 -dinit sp:0xCO0 -fmotsl
Done.
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The FlashLoader allows one to Erase, Program the FLASH or EEPROM.



Erase command:

The command to erase FLASH is the letter E or e as shown. The error message
Vip Not Present will show up if the Vfp switch SW3 is not in the ON position.

Slide the Vfp switch to ON. An Erased message will show for a successful

erasure of FLASH as shown.
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Programming:

To program select the letter P or p command as shown.
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Once the programming is invoked, the MCU is now waiting to be programmed.

Press the Browse button to help locate the test.s19 file. Select test.s19 then

press the open button.
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Once the correct file is selected, press the Download button to initiate upload to
Adapt912B32. A progress Bar will indicate that the file is being transferred. After
which an error box will pop up. Press OK button to continue.

Eror x|

@ Waiting ko receive " buk got

Press the CR or Enter key to bring up the FLASH loader menu. Note the
Programmed message as shown. This is to show that the FLASH was
programmed successfully.
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Move Vfp switch SW3 = OFF and JB2 PADO0:PAD1 = 0:0 and press the RESET
button. The LED on the Adapt912B32 that is connected to PP7 will begin to
blink.

This concludes the use of ICC12 with Adapt912B3260 to using the FLASH
Loader.



